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Introduction 
SpAn is demonstration software for any DCAM-API compliant camera which supports Line 

Sensor Mode (Full Line Binning). Current supported cameras are some versions of C9260-930, 
C10990-600 and C11013-1000 series. SpAn shows a line profile of captured data by Line Sensor 
Mode. 
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Menu 
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This is an example of the draw area. Menu, Tool bar and Status bar are explained later. 

Part Line Area 

Part Line 

Main Line 

Sub Line 

Status Bar 

The draw area is divided into two sections. The top draw area, “All Line”, will always display the 
complete line profile. So if the width of CCD is longer than the width of window, “All Line” 
condenses the line profile to the width of window. The bottom draw area, “Part Line”, will display 
the portion of the line profile that is highlighted in blue in the “All Line” area. It may be necessary 
to expand the window in order to highlight the complete “All Line” profile. 

 

If you reset moving light blue area in dragging, you should move mouse pointer outside “All 
Line”. Default width of Light blue area is the width at which the CCD and Window are coupled 1 to 
1. Changing the zoom ratio, one pixel of CCD is drawn by 2 or 4 pixels of “Part Line” window. So 
when Window size or zoom ratio is changed, the light blue area range is changed too. The center of 
the light blue area is fixed and both ends are adjusted accordingly. 

“All Line” and “Part Line” can display 2 lines, a red line and a blue line. When using Line capture 
mode, the red line is the main line and displays the captured data, while the blue line is a reference 
line that can be displayed for comparison. When using the Multi-Line capture, the red line is the 
upper region and the Blue line is the lower region. 
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Menu 
 There are the following items in Menu. 

· File > Open, Save As, Save Plus 

· Edit > None 

· View > Mark, Zoom, Tool bar, Status bar 

· Measure > Line Profile, Multi-Line Profile, Adjust, Idle 

· CompareLine > View, Capture, Load 

· Correction > Dark, Shading, Integration, Mark XScale, Mark YScale, 

New DarkData, New ShadingData 

· Parameter > Exposure time, Gain, Cooling, Sampling Frame, Scan Mode, 

Multi-Line Binning, Capture Mode 

· Help > About SpAnCamera info 

 

The following explains in detail. 

 



File Menu 
Record profile data in text, read profile data from text. 

Data format of line profile is given in the following example. After the comments, the data is 
written in the order of “Index Number” and “Profile Value1”, “Profile Value2”…. The number of 
profile values is changed by the method of measure. 

 

 

2, 1754
1, 1804 
# Correct Integration(sampling frame: 30 ) 
# Scan Mode : Line Scan (Index Line) 
# Gain : 0 
# Exposure Time : 0.01[s] 

ex:format of line profile 

 
# Correct Integration(sampling frame: 30 ) 
# Region0: (pos=0 height=10), Region1: (pos=15 height=10), Region2: (pos=30 height=10), 
1, 500, 627, 574, 

# Scan Mode : Multiline Scan 3(Index Line) 
# Gain : 0 
# Exposure Time : 0.01[s] 

ex:format of multi-line profile 

Open(Ctrl + O) 
Read profile data except for multi-line from text. When the head of line is “#”, this line is a 

comment line. Exposure time, Gain, Scan Mode comments are always in the file. If other comments 
have the word of “Dark” or “Shading” or “Integration”, this data correction has been applied and the 
profile value is the value after correction. 

Save As (Ctrl + S) 
Records profile data of drawn line in text. First line is recorded exposure time information. 

Second line is recorded gain mode information. Third line is recorded scan mode information. If 
profile data is corrected, correction information (kind, condition) is recorded from forth line. On 
multi-line mode, setting region information (position, width) is recorded after correction 
information. Next line is first profile value. When the camera is capturing, SpAn stops the camera 
from capturing and records profile data in text. After recording data, SpAn starts the camera 
capturing again. 

Save Plus 
 “Save plus” and “Save As” are much the same. The difference is that “Save plus” automatically 

adds a series number to the end of the filename. First time “Save plus” is selected, you input a 
filename to record in the dialog box. When the end of the filename is a number, the end of next 
filename is this number + 1. When the end of filename isn’t number, next filename adds “1” to the 
end of the filename. 
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Edit Menu 
 No function 

 

View Menu 
Shows / hides coordinate values on the grid lines and selects the zoom ratio. In addition this 

shows / hides “Tool Bar” and “Status Bar”. 

Mark 
Shows / hides X and Y coordinate values on grid lines in the Draw Areas. 

Zoom 
Sets zoom ratio between the CCD pixels in “All Line” and the Window pixels in “Part Line”. The 

zoom ratio is 100% or 200% or 400%. 

Tool bar 
Shows / hides tool bar. 

Status bar 
Shows / hides status bar. 
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Measure Menu 
 Captures / idles the camera. 

Line Profile 
This is the main function which captures the line profile for the spectroscope. The sensor mode is 

changed to Line Sensor Mode in which all pixels in the vertical direction are binned. 

MultiLine Profile 
Captures line profiles for vertical binning in up to setting regions. Sensor mode is changed to 

MultiLine Sensor Mode for binning a specified number of adjacent vertical pixels, starting at the 
specified row. The number of regions that can be set is different by the camera. You can set the 
regions of a number that is larger than two if the camera support, but the maximum number SpAn 
can show is two. Therefore you should set color of each line and select shown lines. You can set 
region information (position, width, color, display) at “Parameter->MultiLine Binning” on the menu 
or MultiRange on the toolbar. Note that this function is not supported by all cameras. 

Adjust 
Captures two line profiles for adjusting the pivot of the camera. Sensor mode is changed to Area 

Sensor Mode for getting 2-dimensional data. This function gets 2 line profiles, one row at the top 
(red line) and one row at the bottom (blue line) on the CCD. Capturing standard light, one can pivot 
the camera to match the peaks and power of both line profiles. 

Idle 
Stops capturing on Line Profile or Adjust. 

 

CompareLine Menu 
Capture or show / hide a reference line profile to compare with the capturing line profile. 

View 
Shows / hides the compare line which is displayed as the blue line. When you use Adjust, the 

bottom line of CCD is blue line. 

Capture 
Copies captured line profile to use as Compare Line and displays as the blue line. You can use 

CompareLine Capture while capturing Line profile data. The moment you select Capture, the 
displayed line profile data is transferred to the blue Compare Line. You can use this function to 
check stability. Please note that you can not save this Compare Line data. If you want to save and 
compare, you have to use Save As and Load. 

Load 
Reads line profile from a saved file to use to compare with capturing Line profile. The Compare 

Line is displayed as a blue line. If the saved text data does not have an equal number of CCD lines, 
SpAn returns an error. 

 



Correction Menu 
Gets data using up to 3 types of correction, switches on/off each correction, and corrects XY 

coordinates. 

Dark 
Switches Dark Correction on / off. If SpAn has no data or Dark data was acquired under a 

different situation, SpAn opens dialog and makes new Dark data when you click OK button. When 
you want to reset Dark data using the same situation as acquired Dark data, you should select 
“Correction -> New DarkData”. The dialog for getting Dark data is explained in New Darkdata. 

Shading 
Switches Shading on / off. Correction table for shading is set from text. There are three kinds of 

formats. 

1. Save format of SpAn 

2. list of “Index, Value” ( file deleted comment from 1) 

3. list of “Value” (file deleted “Index” from 2) 

Reads data in both Line Scan and Area Scan. But SpAn opens error dialog when current sensor 
mode and data is different. If you want to use different shading data, you should select “Correction -
> New ShadingData”. 

Integration 
Switches Integration Correction on / off. SpAn stocks n frames, and calculations weighted mean. 

The number of stocked frames is default number 30. You can set the number of stocked frames on 
“Parameter -> Sampling Frame”. If Integration Correction changes to off, stocked data is deleted. 
The formula for weighted mean: 

  
ak : array of stocked data 
(a1 : newest data) 
n : number of stocked data 
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Mark XScale 
Corrects X coordinate values. When two current values and two new values are input, SpAn 

interpolates all other position values. The dialog of this function has default button. This button 
changes X coordinate value to default value. Default value is a sequential number starting on the left 
side at 0 and counting up by one pixel at a time. It is recommended to click the default button (start 
with pixel position) before correcting for an exact interpolation. 

 

Please input them referring to 
coordinate of  

Status Bar or auxiliary line 
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Mark YScale 
Corrects Y coordinate value. This correction is setting the max value on the Y scale. You can 

select one of 3 methods to set max value. Selecting default, SpAn sets to max value of CCD. 
Selecting auto, SpAn gets max value of line profile and sets 125% of this value, the max value of 
the line profile is then 80% of draw area height. Selecting input, SpAn sets the value that you input 
in edit box. When using default or auto, the Y scale values are displayed in the edit box but cannot 
be changed. The Y scale for each draw area (“All Line”, “Part Line”) are set separately and can be a 
different setting type. If you select the checkbox “AutoAdjustMin”, Y coordinate minimum value 
changes automatically on auto. This setting is available on the toolbar as “Current”. 

While the dialog box is open, the drawing area may be previewed. If you click Cancel button the 
value of edit box isn’t reflected, the draw area returns to the previous setting and the dialog box is 
closed. 

 

 

Setting Value by Auto 

Input Value by user 

If AutoAdjustMin is checked, min 
value is changed on Auto. 
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New DarkData 
Gets data for Dark Correction. When you want to use this function, the camera should be idle. 

Getting dark data, SpAn saves situation (Sensor Mode, Exposure Time, Sampling Frame and Gain). 
And SpAn checks situation of using dark data. 

After the camera is set up for capturing dark data, please click OK button on the dialog. On 
clicking OK button, SpAn starts to get captured data. The dialog shows progress bar and the 
remaining number of frames. During this acquisition, if the conditions change for getting dark data, 
please click Cancel button. When you click Cancel button, message box is opened to ask whether 
new dark data is made by current data or not. If you click Cancel button on this message box, dark 
data is deleted and does not return to the previous data. Please take care. 
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Current situation 
Set each value by Parameter menu. 
 

New ShadingData 
Gets data for Shading Correction from text data. Either data of Line Scan or Area Scan is OK to 

use, but the Scan Mode of text data needs to be the same as the current Scan Mode and the number 
of elements of data must match the CCD width. 

 



Parameter Menu 
Sets the modes for capturing and the conditions for correcting 

Exposure time 
Sets exposure time. Please input an exposure time in the edit box of the dialog. After inputting 

value, when you click the OK button, SpAn sets the exposure time to the camera. Note that it is 
important to confirm the current sensor mode. SpAn sets a value based on the current Sensor Mode. 
So when the Sensor Mode is changed, the intensity value will change accordingly. This function is 
used by the capture mode. It is suggested to use the Scan Mode function when setting the exposure 
time if it is necessary to switch between scan modes as well. 

 

Current Sensor Mode 

Possible exposure time range 

Gain 
Sets Gain mode. Please set the gain to a value within the displayed value range. When you click 

OK button, input value is set on the camera. 

 

Cooling 
Sets cooling target temperature. The value you can is two, default value or peculiar value. You 

can change by slide bar. Note that this function is not supported by all cameras. 
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Sampling Frame 
Sets number of sampling frames for Dark and Integration Corrections. The default value is 30 for 

both corrections. If you change number, you change the setting situation and the Dark data (dark 
table, stocked data) is no longer valid. It will be necessary to select Get New Dark for the dark 
correction data. 

Scan Mode 
Sets Sensor Mode, Trigger and Exposure time. When you want to use this function, the camera 

should be idle. When Sensor Mode is changed, support of trigger, setting trigger and exposure time 
are likely to change. So please input selections from top to bottom. SpAn supports only “Internal” 
and “SyncReadOut” trigger modes. 

 

MultiLine Binning 
Sets region information for multiline binning. you can set the region start position, height, color, 

and display. This dialog shows 5 parameters for the region. From the left, they are shows/hide, 
region number, start position, height, and color. 
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Add/Delete 

Show/Hide 

Start Position 

Height 

Color 

Formatted: Centered

Formatted: Centered

Formatted: Centered

Formatted: Centered

Formatted: Centered



Line Profile Shows / Hides 
You can control show or hide by the check box. The checked line is shown. But the maximum 

number of shown line is two. So when you check three lines, the dialog showed right open. Then 
you should uncheck uninterested line, and check interested line. 

 

Region Number 
The region number is set from top automatically when the region is added or deleted. You can add 

and delete region by “+” and “- “button on left. When you click “+”, new region is created under the 
focused region. When you click “-”, the focused region is deleted. If no region is focused, the most 
bottom region is based region. 

Start Position of Region 
When one region has focus, the frame of region name is enabled on right. In this frame, there are 

input value range and edit boxes. The left edit box is for setting start position, the right edit box is 
for setting height. Each parameter has value range up each edit box. The value range is changed by 
other region setting and own setting. When you input value in the edit box, the value affects the 
value of list. When the value of list is red, the value is out of range. 
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Height of Region 
It is same as Start Position of Region. 

 

Start position 

Region Number 

Height 

Formatted: Centered

Formatted: Centered

Formatted: Centered
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Color of Line Profile 
If Auto Color is checked (default), when you create new region, the color is set automatically. 

Otherwise the color of list is gray. This means the color isn’t set. When you want to set color, you 
should click the color. Then Windows dialog for setting color run. You can set color by selecting 
color. 

 

The following explains the value setting and the different point on Capture and Idle. 

 When you change one value, “Set button is enabled”. On clicked “Set” button, SpAn sends the 
parameter to the camera. If input value is uncorrected, Error dialog runs. You should check input 
value before clicking “Set” button. 

 This dialog can run on capture. When this dialog runs, you can start capture. But you can change 
show/hide line profile only. You can’t change the region. You want to change show/hide, you don’t 
have to click “Set” button. When you set Y scale auto and check “Reset Y-Scale”, on changing 
shown profile, Y scale is reset. 

 

Help Menu 

About SpAn 
 shows version number of SpAn. 

Camera info 
shows information of the camera. 

 



Tool Bar 
 : reads line profile from text.(Open) 

 : saves line profile to text by adding series number. (Save plus) 

 : shows / hides X and Y coordinate value on additional lines. (Mark) 

  : zoom up line profile of bottom draw area. (Zoom) 

 : zoom down line profile of bottom draw area. (Zoom) 

 : capture line profile on Line Sensor Mode. (Capture) 

 : capture top and bottom line profile on Area Sensor Mode. (Adjust) 

 : capture line profile of selected region on MulitiLine SensorMode( Mutilt ) 

 : stops capturing. (Idle) 

 : shows / hides compare line. (View) 

 : copies current captured line profile to compare. (Capture) 

 : reads line profile from text to compare. (Load) 

 : switches Dark Correction on / off. (Dark) 

 : switches Shading Correction on / off. (Shading) 

 : switches Integration Correction on / off. (Integration) 

 : corrects X coordinate value. (Mark XScale) 

 : corrects Y coordinate value. (Mark YScale) 

 : sets Y coordinate value from current captured line profile. 

 : sets exposure time. (Exposure time) 

 : sets sampling frames for Dark and Integration. (Sampling Frame) 

 : sets Sensor Mode, Trigger Mode and exposure time. (Scan Mode) 
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Status Bar 
 Shows coordinate of Main Line and information of Compare Line. 

 

Show profile value on 
mouse pointer. 

Show the used corrections and sensor 
mode in compare line. When 
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correction is not used, this is shown 
as blank. 

Deleted: Unused 
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